Lesson 1

Introduction to Mastercam V9

Introduction To Mastercam V9
Lesson 1 is developed to get you the user, familiar with the Mastercam software. You
will be introduced to the screen layout as well as the tools and menus. This lesson has
tools, menus and a quick key list that will be a valuable resource throughout the entire
book.
There are a few short tutorials that take you through the steps required to create lines,
circles and rectangles. These short tutorials show you how to create basic geometry but
also demonstrate how to get a round in the Mastercam environment.
The next section shows you where and how to make some basic customizations to the
Mastercam layout, such as background color, grid size etc.
The last section is a short summarization of the entire lesson. This lesson also has the
Lesson 1 Review section which consists of twenty review questions. If a hands-onreview is what you’re best at there are five practice exercises in the Lesson 1 Exercises
section.

Lesson 1 Objectives
The objective of this lesson is to introduce you the user to Mastercam V9. When you are done
with this lesson you should have an understanding of the following:
a.) How to start Mastercam V9 and know what some of the start options are.
b.) Mastercam V9 screen layout.
c.) Mastercam V9 tool options.
d.) Mastercam V9 quick key options.
e.) How to start and save a Mastercam V9 design file.
f.) How to create a basic 2D geometry.
g.) How make basic modifications to the Mastercam properties.

1-2

Introduction To Mastercam V9

The purpose of this Lesson is to give you the user the knowledge (tools) to get around in
the Mastercam V9 and the tools to create simple geometry. This information is a vital
foundation for the following lessons to build upon.

Starting Mastercam V9
It is assumed that you have some computer experience in basic windows operations. If
this is not the case consult your Microsoft Windows handbook and/or Help file. You can
access the windows help menu under Start (lower left corner of your computer screen)
then select Help.
After the computer has been started and the boot up is completed look on the
Windows Desktop for a Mill 9 shortcut. Reference the shortcut icon to the
right. If a shortcut is not available complete the following steps to start
Mastercam (reference Figure 1.1):
1.) From the Windows desktop select Start from the lower left of your computer
screen.
2.) Select All Programs. All Programs displays all the software programs loaded
and available on your computer. Scan through the list until you locate the
Mastercam 9 option.
Figure 1.1

Screen Layout & Tools
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3.) Select Mastercam 9 from the programs list. This will bring up a list of
Mastercam options. The Design 9 option will allow you to create geometry only.
The Mill 9 option will allow you to create geometry and create tool paths. To
simplify the step select the Mill 9 option.
4.) Depending on your Mastercam license and setup, you will be prompted to accept
the license agreement prior to being allowed to enter Mastercam V9. Accept the
license agreement to enter Mastercam V9 program.
You know that you are in Mastercam program when your screen looks similar to the one
shown in Figure 1.2. At this point you can open an existing file or start a new one. The
following section familiarizes you with the Mastercam screen layout and tools.
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Mastercam V9 Standard Menus And Tools
The following standard screen layout shows you where different tools and tool bars are
located. The numbers coordinate with the following pages where the tool label is bolded.
The tool label is followed by a brief explanation and in some cases, steps on how to use
and/or access the tool.
Figure 1.2
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The following list of menus is not meant to be a comprehensive definition of every tool
on the standard Mastercam V9 screen. The purpose is to provide a quick reference and
an introduction with a brief explanation. If more detailed information is needed and/or
required, refer to the Mastercam V9 Help menu and/or Internet homepage.

Screen Layout & Tools
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Menu 1
The Mastercam Program Identifier
This part of the screen is used to identify the particular
Mastercam program that is loaded and the program version. The options are Mill, Lathe
and Design.

Menu 2
Toolbar Menu

This horizontal bar of tool icons stretches across the entire upper portion of the screen.
The icons represent tools that can be accessed in the design and mill operations. Most of
the tools can also be selected from the Main Menu area as well. The following gives a
brief description on each tool. Alt + B hides/shows the toolbar. Some tools bring up
windows, some menus and others are just toggle tools.

Tool
Bar

Tool
Name
Previous
Page
Next Page
Help

File

Analyze

Screen
Zoom
Screen
U

Tool Definition
This tool allows you to scroll back through the Toolbar menu.
There are too many tools to be displayed all at the same time
thus the need for the scroll tools.
This tool allows you to scroll forward through the Toolbar. It
scrolls opposite direction of the previous tool.
This tool brings up the Mastercam V9 Help window. This is a
very helpful tool, use it! Alt + H is the Help quick key.
This tool can also be selected from the Main Menu. Select
either the tool icon or from the Main Menu and the Menu
Heading changes to the active tool. Reference Menu 3. If you
select the tool icon reference the Main Menu (Menu 4) to
display the additional options under File.
This tool allows you to analyze the design and or mill geometry
created on the work area of the screen. Notice that the Analyze
option is also listed on the Main Menu. When either the icon or
Main Menu options is selected the additional options are
displayed.
The user is prompted to select a rectangular window to zoom in
on.
This tool automatically unzooms (zooms out).
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Unzoom
Unzoom by
0.8
Screen Fit
Screen
Repaint
Gview Dynamic
Gview Isometric

Zooms out from the displayed image in increments of 0.2.
This tool automatically fits the displayed image to the graphic
screen area.
Refreshes the screen, gets rid of remnant geometry.

This tool allows the user to rotate the geometry in all three
dimensions.
This tool allows the user to view the created geometry from an
Isometric View point.
This tool allows the user to view the created geometry from a
Gview -Top
Top View point.
This tool allows the user to view the created geometry from a
Gview Front View point.
Front
This tool allows the user to view the created geometry from a
Gview Side View point.
Side
The construction plane is the active plane that the geometry is
Cplaine created on. This tool makes the top plane the active construction
Top
plane.
This tool makes the front plane the active construction plane
Cplane Front
This tool makes the side plane the active construction plane.
Cplaine Side
This tool makes it possible to create geometry in 3D. The
previous three tools restricted geometry creation to 2D. This
Cplane-3D
means you must define geometry in terms of 3D, such as a point
requires an X, Y and Z value.
This tool allows the user to delete selected geometry.
Delete
DeleteUndeleteSingle
Screen
Change
Colors
Screen
Clear
Colors

This tool allows you to undo the last deletion.

This tool brings up the Change Color menu. The tool allows the
user to change the color of selected geometry.
This tool makes all geometry the same color and/or group.

This tool allows you to undo the last operation as long as you are
in the same menu the operation was executed in.
Screen Surf This tool allows you to apply the shading to surfaces.
DispShading
This tool brings up the Blank menu allowing you to blank select
Screengeometrical entities.
Blank
Undo

Screen Layout & Tools

Screen
Statistics
CreateLine
Create-Arc
CreateFillet
CreateSpline
CreateRectangle
CreatePoint
CreateSurface
CreateSolid
Create
Solids
History
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This tool list all the geometrical entities created. The
information is displayed in the Prompt Zone.
This tool brings up the Create/Line menu.
This tool brings up the Create/Arc menu.
This tool brings up the Create/Fillet menu
This tool brings up the Create/Spline menu.
This tool brings up the Create/Rectangle menu.
This tool brings up the Create/Point menu.
This tool brings up the Create/Surface menu.
This tool brings up the Create/Solid menu.
This tool brings up the Solids History. This tool allows you to
see the steps used to create the resultant solid.

Menu 2
Toolbar Menu Continued

This horizontal bar of icons is what will be displayed when you select the Next tool.
Previous Page Use this button to scroll through the Toolbar.
Next Page

Use this button to scroll through the Toolbar.

Modify-Trim1 Entity
Modify-Trim2 Entity
Modify-Trim3 Entity
Modify-TrimDivide
ModifyExtend

This tool brings up the Modify/Trim/1 Entity function in the
Prompt Zone.
This tool brings up the Modify/Trim/2 Entity function in the
Prompt Zone.
This tool brings up the Modify/Trim/3 Entity function in the
Prompt Zone.
This tool brings up the Modify/Trim/Divide function in the
Prompt Zone.
This tool brings up the Modify/Extend menu. Also notice the
information displayed in the Prompt Zone.
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Modify-Break This tool brings up the Modify/Break menu.
This tool brings up the Modify/Normal menu. This tool deals
specifically with surfaces.
This tool brings up the Modify/Mirror menu. This tool is a
shortcut for the Xform option found in the Main Menu.
This tool brings up the Modify/Rotate menu. This tool is a
Xform-Rotate
shortcut for the Xform option found in the Main Menu.
This tool brings up the Xform/Scale menu. This tool is a
Xform-Scale`
shortcut for the Xform option found in the Main Menu.
This tool brings up the Xform-Translate menu. This tool is a
Xformshortcut for the Xform option found in the Main Menu.
Translate
This tool brings up the Offset window. This allows you to
Xform-Offset
create duplicate entities a specified distance apart.
This tool is a toggle tool from the following information: The
quick key is F9.
Screen
- Current axis system.
Display Info
- Current geometry file information.
- Current Toolpath file information.
This tool tracks the location of the cursor, it is a toggle tool.
Cursor
Tracking
(Toggle)
This tool brings up the Create/Drafting/Dimension menu.
CreateDraftingDimension
This tool brings up the Drafting Global window. This
Draft Global
window is where you set the drafting parameters.
This tool brings up the System Configuration window. This
Screen
window is where you can set Mastercam default and systems
Configuration
defaults.
This tool brings up the Tooplpaths/Contour menu. The tool
Toolpathsis used to create a Contour Toolpath.
Contour
This tool brings up the Tooplpaths/Drill menu. The tool is
Toolpathsused to create a Drill Toolpath.
Drill
This tool brings up the Tooplpaths/Pocket menu. The tool is
Toolpathsused to create a Pocket Toolpath.
Pocket
This tool brings up the Tooplaths/Flowline menu.
TooplpathsFlowline
This tool brings up the Toolpaths/Surface menu.
ToolpathsSurface
This tool brings up the NC Utils/Backplot menu.
NC UtilsBackplot
This tool brings up the Mastercam Rebuilds Display List
Screenwindow. This tool is used to optimize Mastercam.
Regenerate
This tool brings up the NC Utils/Filter menu.
NC UtilsFilter
ModifyNormal
XformMirror

Screen Layout & Tools
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File-dos Shell
File
Communic
Screen
Viewport
File New
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This tool brings up the NC Utils/Post Proc menu.
This tool brings up a DOS window and Dos prompt.
This tool brings up a Communications window.
This tool brings up the Viewport window. The tool allows
you to define multiple screen configurations.
This tool allows you to start a new Mastercam session.

Create Ellipse This tool brings up the Create Ellipse window.
Create LineMulti
Create-LineHorizontal
Create-LineVertical

This brings up the Create/Line/Multi menu. This tool is a
quick way to creating a line using a specific method.
This brings up the Create/Line/Horizontal menu. This tool is
a quick way to creating a line using a specific method.
This brings up the Create/Line/Vertical menu. This tool is a
quick way to creating a line using a specific method.

Menu 2
Toolbar Menu Continued, Again

This horizontal bar of icons is what will be displayed; select the Next tool for the second
time.
Previous
Page
Next Page
CreateLineEndpoints
CreateLine-Polar
CreateLineParallel
Create-ArcPolarCenterpoint
Create-ArcEndpoints

Use this button to scroll through the Toolbar.
Use this button to scroll through the Toolbar.
This brings up the Create/Line/Endpoints menu. This tool is a
quick way to creating a line using a specific method.
This tool brings up the Create/Line/Polar menu. This tool is a
quick way to creating a line using a specific method.
This tool brings up the Create/Line/Parallel menu. This tool is
a quick way to creating a line using a specific method.
This tool brings up the Create/Arc/Polar/Centerpoint menu.
This tool is a quick way to creating a circle/arc using a specific
method.
This tool brings up the Create/Arc/Endpoint menu. This tool is
a quick way to creating a circle/arc using a specific method.
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File
Ramsaver
Screen
Change
Attributes
Toolpaths
Job Setup
Toolpath
Oparations
Manager
WCS View
Manager
Delete Last
Operation
Create
Drafting
Create
Dimension
Horizontal
Create
Dimension
Vertical
Create
Dimension
Parallel
Create
Dimension
Angular
Create
Dimension
Circular
Crdmrad
Create
Dimension
Baseline
Create
Dimension
Chained
Create
Dimension
Ordinate
Create
Dimension
Point

This tool allows you to automatically delete duplicate geometry.
This tool brings up the Screen Change Attributes window. This
window allows you to specify the attributes of geometrical
entities.
This tool brings up the Toolpaths Job Setup window. This
window is where you can define the parameters of a toolpath
such as raw stock, toolpath configuration and material.
This tool brings up the Toolpath Operations Manager window.

This tool brings up the WCS View Manager window.
This tool allows you to delete the last toolpath operation.
This tool brings up the Create Drafting menu.
This tool brings up the Create/Drafting/Dimension/Horizontal
menu.
This tool brings up the Create/Drafting/Dimension/Vertical
menu.
This tool brings up the Create/Drafting/Dimension/Parallel
menu.
This tool brings up the Create/Drafting/Dimension/Angular
menu.
This tool brings up the Create/Drafting/Dimension/Circular
menu.
This tool brings up the Create/Drafting/Dimension/Circular
menu.
This tool brings up the Create/Drafting/Dimension/Baseline
menu.
This tool brings up the Create/Drafting/Dimension/Chained
menu.
This tool brings up the Create/Drafting/Dimension/Ordinate
menu.
This tool brings up the Create/Drafting/Dimension/Point
menu.

Screen Layout & Tools

Create
Drafting
Label
Create
Drafting
Hatch
MacroRecord
(Toggle)
MacroPlayback
(Toggle)
MacroPause
(Toggle)
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This tool brings up the Note Dialog window. The Note Dialog
window allows you to create text notes.
This tool brings up the Hatch window. This window allows you
to select the type of hatch you want to apply to the geometry.
This tool allows you to Create and save a Macro.

This tool allows you to load and Play a Macro.

This tool allows you to Pause the current Macro.

Menu 3
The Main Menu Identifier

This area of the window identifies the active menu option. The options can be selected
from the Main Menu selection or from the Toolbar option.
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Menu 4
The Main Menu
The options shown in this menu are Mastercam V9’s main tools. Notice that most of the
options also are the first few tools represented in the Toolbar (Menu 2). Once the main
option is selected the next level of options are displayed. Menu 3 helps you keep track of
where in the menu option you are by labeling the menu option. Notice that the each
options has one letter underlined. The under lined letter is a Quick Key to activating the
particular tool.

Tool Bar

Tool Name

Tool Definition

Analyze

This option allows you to analyze the design and or mill
geometry in the work area of the screen.

Create

This option allows you to create geometrical and drafting
entities, such as lines and dimensions.

File

This option allows you to save, get, import and/or export
Mastercam files.

Modify

This option gives you access to all the tools used to
modify existing geometry such as trim and extend.

Xfrom
Delete
Screen
Solids
Toolpaths
NC Utils

This option gives you access to all the tools that allow
you to transform existing geometry such as mirror and
rotate.
This option allows you several different methods of
selecting the entities you want to delete.
This option gives you access tools that allow you to
modify and or define all parameters related to the
Mastercam screen and layout defaults.
This option gives you access to the Solids tools.
This option is where you go to create the toolpaths such
as contour, drill and pocket.
This option is where you have access to the toolpath
defaults, setup and verification tools.

Screen Layout & Tools
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Menu 5
The Backup Menu Tool

This tool is a handy tool, it allows you to backup one menu level at a time.

Menu 6
The Main Menu Tool

This tool allows you to jump directly back to the main menu no matter where or what
level of a particular menu you are at.

Menu 7
The Secondary Menu Tools
This Toolbar controls the graphical aspect of the entities in the work area.

Tool Bar

Tool Name

Tool Definition

Z: Height

This status bar indicates the current Z value.
This status bar indicates the current color and its
assigned number.
This status bar indicates the current (active) Level.
Selecting this tool brings up the Level Manager
window. From this window you can create and change
the current level.
This tool brings up the Attributes window. In the
Attributes window you can change the color, type and
thickness of the geometrical entities.
This tool brings up the Groups window. In this
window you can create new and modify existing
groups.
Selecting this tool will bring up the Level Manager
window where you can turn the levels Off or On
(mask). This tool also gives the current status of the
Mask.

Color:

Level:

Attributes

Groups

Mask:
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WCS:
Tplane:

Cplane:

Gview:

This tool brings up the View Manager window.
This tool brings up the Tool Plane menu, where you
can specify what tool plane you require (Front, Top,
Side…). Notice it also shows the status (active
TPlane).
This tool brings up the Construction Plane menu,
where you can specify what tool plane you require
(Front, Top, Side…). Notice it also shows the status
(active CPlane).
This tool brings up the Gview menu, where you can
specify what specific view you want your geometry to
shown in. Notice it also shows the status (active
Gview).

Menu 8
The Prompt Zone

This area of the screen is reserved for prompting the user for specific input. The prompt
message will depend on what tools has been selected. The example shown is the prompt
message after selecting Create from the Main Menu and Line in the second level menu.

Menu 9
The Units Display

This area of the screen is dedicated to identifying the units the file is being created, edited
and saved in.

Screen Layout & Tools
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Menu 10
The Axis Orientation

This tool shows the orientation and/or working plane. By default you will be working in
the X, Y plane as shown. If you rotate to a new work plane the Axis will show you the
current orientation three dimensionally as shown below the two dimensional axis.

Menu 11
The Zoom Screen Scale
This information displays the zoom screen value. This display can be turned off selecting
the F9 key. If you select the Alt + F2 you can verify the zoom value to change in
increments of .2.

Menu 12
The Axis Identifier

The first axis is two dimensional with the x, y plane active. The second axis is rotated to
an isometric view. This tool helps identify the orientation of the work space as well as
the 0,0,0 point. This tool is a toggle tool, F9 turns the axis display on and off.
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Menu 13
The Cursor Location Display

This area is dedicated to displaying the location of the cursor in the work area. You can
move the cursor around in the work space. Notice the values update to the new location
of the in reference to 0,0,0. Alt + F3 toggles this display On and Off.

Menu 14
The Standard Window Tools

These tools are the standard Microsoft Windows tools. The options are to Minimize the
current Mastercam window, Customize the window size or Exit out of the current
Mastercam window. If you exit out without saving the current file, Mastercam will
prompt you to Save or Exit without saving.

Menu 15
The Work Area
This area is where the geometry and tool paths are created and modified.

Screen Layout & Tools
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Mastercam V9 Function Keys and Quick Keys
Quick
Key

Function
Name

F1

Zoom

F2

Unzoom

F3

Repaint

F4
F5
F6
F7
F8

Analyze
Delete
File
Modify
Create

F9

Display
Information

F10

Function
Assignment
window

Alt+F1

Screen Fit

Alt+F2

Scale Zoom
Cursor
Location

Alt+F3
Alt+F4

Alt+F5

Alt+F6

Alt+F8

Alt+F9
Alt+A

Mastercam
Exit window
Delete
Window
Menu
Type of File
to Edit
Menu
System
Configure
window

Function Discription
Shortcut to the Screen Zoom tool. You can use this tool to
magnify specific area of your geometry.
Shortcut to the Screen Unzoom tool. This tool zooms out
every time you push this function key.
Shortcut to the Screen Repaint tool. This tool updates the
screen and displays only the current active entities.
Shortcut to the Analyze menu.
Shortcut to the Delete menu.
Shortcut to the File menu.
Shortcut to the Modify menu.
Shortcut to the Create menu.
This quick key displays the following information:
- Current System Construction Origins (screen axis).
- Zoom value.
- Current Mastercam file name (Prompt Zone).
- Current Tool Path file name (Prompt Zone).
This quick key brings up the Function Assignment window.
This tool allows you to assign your own quick keys.
This quick key automatically zooms the screen to fit all
entities within the screen.
This quick key automatically zooms out in increments of 0.2.
This quick key toggles the Cursor Location display on and
off. Reference Menu 13.
This quick key brings up the Mastercam Exits window.
This window will ask if you are sure you want to exit
Mastercam.
This quick key brings up the Delete Window Menu.

This quick key brings up the Type of File to Edit Menu.

This quick key brings up the System Configure window.
This lesson introduces some of the options available.

This quick key displays the current World View Axis
Display Axes (center), the current Construction Plane Axis (lower left),
and the current Tool Plane Axis (lower right).
This quick key brings up the AutoSave window.
Autosave
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Alt+B

Alt+C

Alt+D
Alt+F
Alt+H
Alt+L
Alt+M

Alt+O
Alt+P
Alt+S
Alt+T
Alt+U

Alt+V
Alt+W
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Window
Horizontal
Toolbar
C-Hooks
Window
Drafting
Global
Window
Fonts
Window
Mastercam
Help
Window
Attributes
Window
Memory
Allocations
Window
Operations
Manager
Window
Prompt
Toggle
Shading
Toggle
Toolpath
Display
Undo
Mastercam
License
Information
Viewport
Window

Alt+X

Set Main

Alt+Z

Level
Manager

Alt+0
Alt+1

Point Menu
Color
Window

This quick key toggles the Horizontal Toolbar on and off.
Reference Menu 2.
This quick key brings up the C-Hook window. From this
window you can select a C-Hook application to run. CHooks are customized programmed Mastercam
programs/functions.
This quick key brings up the Drafting Global window. This
window is where you set all the drafting parameters.
This quick key brings up the Font Window. This window is
where you can set the default text font and size.
This quick key brings up the Mastercam Help Window.
This lesson introduces the Mastercam Help window and how
to use it.
This quick key brings up the Attributes Window. This
window is where you can set line type, thickness and color.
This quick key brings up the Memory Allocation Window.
This is a diagnostic tool only.
This quick key brings up the Operations Manager
Window. This window displays the existing toolpaths and
toolpath properties.
This quick key toggles the Prompt Area on and off.
This quick key toggles the Shading on and off.
This quick key toggles the Toolpath display on and off.
This quick key allows you to undo the last step/operation
completed in Mastercam. This option is available only in the
operation that the last entity was created in.
This quick key brings up the Mastercam software version
and serial number of your SIM.
This quick key brings up the Viewport Window. This
window lets you set the viewport configuration.
This quick key allows you to set the color, level, style and
width of an entity. The options are displayed in the Prompt
Zone.
This quick key brings up the Level Manager window. This
window is where you can create and set parameters for
different levels.
This quick key brings up the Point Menu.
This quick key brings up the Color Window. The Color
Window allows you to select a color for entity creation.

Screen Layout & Tools

Alt+2

Level
Manager

Alt+3

Mask Level

Alt+4
Alt+5

Alt+’

Alt+Tab
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This quick key brings up the Level Manager Window.

This quick key brings up the Level Manager Window. This
allows the user to set the Mask level.
This quick key displays the Tool Plane information in the
Tool Plane
Prompt Zone (Tplane).
(Tplane)
Construction This quick key displays the Construction Plane information
in the Prompt Zone (Cplane).
Plane
(Cplane)
This quick key brings up the Create/Arc/2pt. circle point
Create-Arcmenu. Make your selections from the point menu to create
2pt. cir
your circle.
This quick key allows you to switch between open window s
Switch
applications. This is a standard Microsoft tool.
between
Open
applications
The Esc key will interrupt the current command.
System
Interrupt

Esc

Press Esc to back up to a previous menu.
Backup key

Page
Up/Page
Down
Cursor
Arrows

Zoom
Pan

To zoom in press the Page Up key. To zoom out press the
Page Down key.
The Cursor Arrows allow you to pan across the screen.

Mastercam V9 Coordinate System
This section reviews the Cartesian Coordinate System. If you have a good
understanding of this system you can skip to the next section. If not this section would be
a good introduction and/or review of how geometry/parts are created and located in the
Mastercam work area.
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There are a few basic concepts that are important to understand and visualize when using
Mastercam V9. The Mastercam V9 work area uses the Cartesian Coordinate System to
create and locate geometry. The Cartesian Coordinate System has a horizontal numbered
line called the x axis. Mastercam refers to the x and y axis as the x and y coordinate. All
numbers on the x axis to the right of 0 are positive and all numbers on the x axis to the
left of 0 are negative. Zero is called the origin. Reference Figure 1.3
Figure 1.3

Figure 1.5

Figure 1.4

There is another number line that
runs vertical (up and down) on the
screen. This vertical line is called the
y axis. Numbers above 0 on the y
axis are positive while all numbers
below 0 are negative. Reference
Figure 1.4.
The x and y axis divides the screen
into 4 equal parts called quadrants.
The first quadrant is the upper right
and other quadrants II, III, and VI
follow in a counter clockwise
direction. Reference Figure 1.5.

To view the x y axis in the
Mastercam work area (screen) select
the F9 function key. The F9 key is a
toggle key that turns the axis on and off. Note that the positive and negative numbers on
the x and y axis do not appear when the F9 key is selected. Figure 1.6 displays all the
concepts presented thus far.

Screen Layout & Tools
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Figure 1.6

Mastercam allows you to create geometry in any quadrant or use a combination of
quadrants. The best quadrant to locate your part geometry in depends on the geometry
and how it will be used. Generally the easiest quadrant to work with is the first quadrant
(quadrant I). Creating the part in the first quadrant keeps all the values positive. If you
are dealing with cylindrical parts the center of the cylinder (circle) would probably be
best located at the Mastercam origin (0,0).

Creating Simple Geometry In The Mastercam V9 Coordinate
System
1 Creating Circles
This section will help you get started on creating some simple Mastercam V9 geometry
as well as get used to moving around the Mastercam V9 menu system. To create a circle
at the origin, complete the following steps (reference Figure 1.7 for all menu options):
1.1 Select the Create tool from the Main Menu.
1.2 Select the Arc tool from the Create Menu.
1.3 Select the Circ pt+rad tool from the Arc Menu.
1.4 The Main Menu area will go blank and you will be prompted in the Prompt
Zone for the radius of the circle. For this step type in the value of 3″.
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1.5 Press Enter key.
1.6 Mastercam V9 will create a circle with a 3″ radius and the Main Menu area now
displays the Point Entry menu. You can drag the circle around the screen. If the
object snap is on you can snap it to the origin (Alt+G). If not you may select
from the Point Entry menu. For this step select the Origin option. This will
place the circle at the origin.
Figure 1.7

1.7 Mastercam also gives you the option to create the 3″ radius circle where ever
you select. Notice that you can drag the circle around the screen, select a
location with the mouse. You can continue to duplicate the circle without any
additional tool selections. Notice in the Prompt Zone the x y location value is
displayed.
1.8 To complete and exit the circle command, select the Esc key. The Esc key exits
the current command. In this example the Esc key moved you back from the 4th
level menu to the 3rd level menu.

Screen Layout & Tools
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As you created the circle(s) there are several things that you might have noticed.
Mastercam uses multiple levels of menus to create a geometry. This multiple menu level
is also used to create tool paths, as you will experience in the latter lessons. The different
levels experienced in creating a circle are represented in Figure 1.7. At any point that
you change your mind you can select the BACKUP menu. This selection takes you back
one menu level where you can make other selections. For example if you selected Polar
option you could select the BACKUP tool and select Circ pt+rad option instead. If you
want to go directly back to the Main Menu and start over you could select the MAIN
MENU tool. Another option that Mastercam allows you to do is to select the Create Arc
tool from the Toolbar option. This will bring up the Arc Menu (3rd Menu Level).
All the circle options were not covered but this should give you a good idea how to create
some circles. It is strongly suggested that you test some of the other circle options. You
need to get to a point that you are comfortable moving around the Mastercam Circle
menus.

2 Creating Lines
This next section will take you through the basics of creating simple lines to complete a
square. With the basic skills under your belt you can explore all the different options. To
create the rectangle shown in Figure 1.9, complete the following steps:
2.1 Select the F9 key to turn on the Mastercam Coordinate.
2.2 From the Main Menu select the Create option.
2.3 From the Create Menu select the Line option.
2.4 From the Line menu select the Vertical option. This will create a line that, you
guessed it, will be vertical. This will bring up a menu that should be somewhat
familiar, the Point Entry menu.
2.5 From the Point Entry menu select the Origin option. This selection makes this
step easy. It will be vertical and start at the origin.
2.6 You can drag the mouse up and down (vertical) on the screen, the preview of line
is displayed. It will be vertical and starting at the origin. At this point you would
have to select the mouse twice to create the line. The first click would determine
the length. The second click would determine location of the vertical line along
the coordinate, but since the starting point is constrained to the origin the second
click would not change the location. Another and more accurate process is to
type in the x, y location of the endpoint. For this step type in 0,2 in the Prompt
Zone.
2.7 Press the Enter key. This brings up the “Enter the x coordinate:” prompt.
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2.8 Type in “0” and press the Enter key. Congratulations you have just created your
first Mastercam line.
2.9 Now you need to create the horizontal line. If you are not yet comfortable with
the Mastercam menu system select the Main Menu tool. This will take you back
to the main menu. If you selected the BACKUP menu once it you would still be
in the Create, Line, Vertical menu. You need to back out enough to select the
Horizontal tool.
2.10 Select Create from the Main Menu.
2.11 Select Line.
2.12 Select Horizontal.
2.13 Select Endpoint option. This option allows you to snap to the closest endpoint
of an existing line.
2.14 Select the top end of the existing line. As your pointer gets close to the
endpoint a snap box will appear indicating that it has located the endpoint of the
line.
2.15 At this point you can drag your pointer horizontally across the screen. The
length of the line corresponds to the location of the pointer. You can arbitrarily
determine the length of line by selecting anywhere. Very few part requirements
allow you such tolerance luxury. To be more exact you can type in the
endpoint of the line, x, y values. In this case type in 2,2. Note: Mastercam
does not prompt you for the x,y location. Once you start to enter a value, the
value option will appear in the Prompt Zone.
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2.16 Press the Enter key. The Prompt Zone will now prompt you for the y value of
the horizontal line. Since it is a horizontal line and located off the endpoint of
the first line it is already constrained to the y value. For this step enter 2.
Figure 1.8

2.17 To create the third line select the Main Menu tool again.
2.18 Select Create.
2.19 Select Line.
2.20 Select Multi.
2.21 Select Endpoint.
2.22 With the mouse select the end of the second line.
2.23 Type in the x,y values for the endpoint of the third line. To create a square the
values would be 2,0.
2.24 To create the fourth and last line, select the Main Menu.
2.25 Select Create Line
menu.

tool from the Toolbar. This is a shortcut to the Line
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2.26 From the Line menu select the Endpoint option.
2.27 Move your pointer to the endpoint of line three, select the endpoint. This
creates the beginning point of the line you are about to create.
2.28 From the Line menu re-select
the Endpoint option.
2.29 Move your mouse over the
origin. Select the end of line 1.
Your square should look
similar to the one shown in
Figure 1.9.

Figure 1.9
Point (2,2)
line 1
line 2
line 3
line 4

This is an introduction to a few of the
different ways Mastercam V9 allows
lines to be created. You are strongly encouraged to try all the options found in the
Line menu. Find a few of the methods that work best for you.

3 Creating A Rectangle
Mastercam V9 does supply a tool to create a rectangle faster than the steps explained in
the previous steps. To create a rectangle using the Rectangle tool complete the following
steps:
tool directly
3.1 Select the Create Menu. You could select the Create Rectangle
from the Toolbar menu. If you selected the tool from the Toolbar menu you could
skip step 3.2.
Figure 1.10
3.2 Select the Rectangle tool.
3.3 Select the 2 Points Option.
3.4 Select the Origin option. As in
the previous steps this will
constrain the first point of the
rectangle to the origin.
3.5 At this point you could arbitrarily
select the size of the rectangle but
since we want an exact size
rectangle type in the x, y value of
the second point of the rectangle.
For this step make it a -2, -2.
What quadrant does this create
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the rectangle in? If you can not answer then reference the Cartesian Coordinate
section of this lesson.
3.6 The 1 Point rectangle option is also a powerful tool. Create a few rectangles using
the 1 Point option.

4 Saving The Newly Created Geometry
At this point you should have quite a bit of geometry (lines, circles and rectangles) on the
screen. Depending on how much additional geometry you have created while practicing
your screen should look somewhat similar to the one shown in Figure 1.10. Figure 1.10
only shows the geometry that was created following steps 1 through 4. If you wanted to
quit Mastercam V9 and save your newly created geometry so you could bring it up and
add to it at a latter date complete the following steps:
4.1 From the Main Menu select File. If you want to select the same option from the
Toolbar option select the File tool, displayed to the right.
4.2 Both options in Step 4.1 will bring up the File menu. In the File menu,
select the Save option.
4.3 This will bring up the Specify File Name to Write window up as shown in Figure
1.11.
Figure 1.11
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4.4 You will have to determine what directory you want to save the file in. If you are not
sure you will have to check with your instructor and/or the systems administrator.
Figure 1.11 shows that it will be saved in the MC9 directory. You can select the
down arrow to the right of the directory to browse to the desired directory.
4.5 In the File Name box type in “Lesson 1 Tutorial”. Notice that the file type (file
extension) will default to MC9. This is shown in the field just below the File Name
box.
4.6 Select Save. This saves the file name in the location (directory) you just specified
and under the name you just specified.
The file is now saved. You can now exit Mastercam or start a new design. To start a
new design select the File, New option. This will bring up a prompt window asking you
if you are sure you want to initialize new geometry. If you select Yes the existing
geometry will disappear and a blank new Mastercam screen will appear. At this point
you could start creating new geometry.

5 Opening An Existing Mastercam Design (File)
You have now created Mastercam geometry and saved it. If you want to load the file you
created and saved in the previous steps or any other existing Mastercam file complete the
following steps:
5.1 Start Mastercam if you have not already done so.
5.2 From the Main Menu select the File option.
5.3 Select the Get option. This brings up the Specify File Name To Read window.
This window is very similar to the one shown in Figure 1.11.
5.4 Select the directory the file is saved in. If you do not know how to do this you will
need to reference the Microsoft Help files.
5.5 If you have the correct directory selected, the file should show up in the list of files.
If it does not you will need to make sure you have specified the correct file extension
in the box labeled “Files of Type”. The extension you want to be listed is MC9.
5.6 Find your file and select it, so it is highlighted. For this step select Lesson 1
Tutorial file.
5.7 Select the Open button at the bottom right of the window. This will open the file
The geometry will show up on the screen just as you have saved it.
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5.8 At this point you could continue to practice creating Mastercam geometry. If you
attempt to exit Mastercam prior to saving your latest changes, Mastercam will warn
you that there are unsaved changes and ask if you want to save the changes. At this
point it is your choice if you want to save your practice geometry, select Yes. If you
don’t want to save your changes, select No and Mastercam will close down without
saving the latest changes.
Although this step specified a particular file to load into Mastercam you should be able to
apply this process to any Mastercam file. You need to get comfortable with this process,
and you will be required to know this information without instruction throughout the
remainder of the lessons.

6 Customizing Mastercam
This one section will not be nearly enough to adequately cover all the customization
options found in Mastercam. This section shows you where to go within the menu
system to customize Mastercam. You will be introduced to the many different options
but will have to do some exploring on your own to customize anything not covered in this
section. To customize the Mastercam screen complete the following steps (reference
Figure 1.12):
6.1 From the Main Menu select the Screen option. The quick key for this option is Alt
+ F8.
6.2 From the Screen menu select the Configure option.
6.3 This will bring up the System Configuration window. This window has ten different
tabs. The tabs that you will probably be most interested in are the Screen, Cad
Settings and Plot Settings tabs. Figure 1.12 shows the Systems Configuration
window with the Screen tab selected. For this step select the Systems Colors
button. This will bring up the Systems Colors window.
6.4 Highlight the Graphic Background Color option and then select the Color button as
shown in Figure 1.12. This will bring up the Color window.
6.5 Select the White color box.
6.6 Select the Ok button to complete the color change. Notice you have to back through
the windows selecting the OK button to apply the change. If you wanted to make
additional changes you could do that prior to selecting the OK button at the System
Configuration window. Once you select the Ok and exit the System Configuration
window the background color will change to white. The default background color
should be black.
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Figure 1.12

This step had you make one simple change but it should show you the way to multiple
possibilities. Figure 1.12 shows you some of the possible options. You are encouraged
to test some of these options out, see what you can do to change your Mastercam
environment.
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7 Getting Help
One last tool that is well worth the time to cover that is the Help tool. You might have to
pickup up on this tool, it is listed in the horizontal tool bar. To get help with Mastercam
complete the following steps (reference Figure 1.13):
7.1 From the Horizontal Tool Bar select the Help tool. This will bring up the
Mastercam Help window.
7.2 As you can see on Figure 1.13 you can get help from an index and or do a search on a
particular subject. This is very similar to any Microsoft Help window.
7.3 Select the Search option.
7.4 In box 1 type in “contour” and hit Enter. Box 2 will show you a list of all the
contour subjects found in the Help file.
7.5 Select the first occurrence of “contour” found in box 2.
7.6 Select the first occurrence in box 3. This will display the help file on that subject in
the text box (to the right). Figure 1.13 currently shows the Screen Menu Help file.
During any lesson if you need more and/or additional information on a specific subject
this tool can be very helpful (yes, the pun was intended).
Figure 1.13
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Lesson 1 Summary
This lesson has briefly introduced you to the tools and processes you will need to
successfully navigate and complete the following lessons. If you feel comfortable with
the tools and processes presented, you are ready to test your knowledge with the Lesson
1 Review and then apply the knowledge to complete the Lesson 1 Exercises. You may
have to reference this lesson numerous times particularly the Toolbar and Quick Key
sections. The geometry creation and File Save/File Get steps need to become second
nature.
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Lesson 1 Review
After completing this lesson you should be able to answer the questions and explain the
concepts listed below.
1. T or F Numbers on the x axis to the left of 0 are positive.
2. T or F Numbers on the y axis above 0 are positive
3. T or F Zero is also called the origin.
4. A point using the Cartesian Coordinate System is specified using the following
format (2,1). What is the value for the x coordinate for the specified point?
a.) 2
b.) 1
c.) Both a and b
5. What is the y value in question 4?
a.) 2
b.) 1
c.) Both a and b
6. If you create lines using the following coordinates, what alphanumeric character
would you create (start at: (3,1) go to (3,0) got to (0,0) go to (0,3) go to (3,3) and
end at (3,2))?
a.) F
b.) V
c.) C
d.) A
e.) None of the above
7. If you create lines using the following coordinates, what alphanumeric character
would you create (start at: (-1, 2) go to (0,0) end at (1,2))?
a.) F
b.) V
c.) C
d.) A
e.) None of the above
8. What menu area contains the following tools: Attributes, Groups, Cplane etc.?
a.) Main Menu
b.) Toolbar
c.) Secondary Menu
d.) Prompt Zone
e.) None of the above
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9. What screen area allows the user to key in value information?
a.) Main Menu
b.) Toolbar
c.) Secondary Menu
d.) Prompt Zone
e.) None of the above
10. The point (15,-10) in the Cartesian Coordinate System is located in what
quadrant?
a.) First
b.) Second
c.) Third
d.) Fourth
e.) None of the above
11. The point (-9,-10) in the Cartesian Coordinate System is located in what
quadrant?
a.) First
b.) Second
c.) Third
d.) Fourth
e.) None of the above
12. Which set of coordinates is in the second quadrant?
a.) (-2,22)
b.) (-22,2)
c.) (-5,5)
d.) All of the above
e.) None of the above

13. The x axis is a _________________ line.
a.) horizontal
b.) vertical
c.) diagonal
d.) All of the above
e.) None of the above
14. T or F If you created all your geometry in the 1st quadrant all the x and y values
would be positive.
15. T or F In Mastercam you can create a line, circle and rectangle by selecting the
tool from both the Toolbar option and the Main Menu option.
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16. What function key displays the coordinate system (axis)?
a.) F9
b.) F13
c.) F8
d.) F1
e.) None of the above

17. T or F In Mastercam, once a circle has been defined you can create multiple
copies of that circle without re-entering the circle variables.
18. Mastercam Undo tool allows a maximum of two steps to be undone.
a.) True
b.) False
19. T or F When a Mastercam file is saved it is assigned the MC9 extension.
20. T or F If you attempt to exit Mastercam without saving your file, Mastercam will
warn you and give you a chance to save prior to exiting the program.
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Lesson 1 Exercises
Test your new learned knowledge by completing the following exercises:
1. Create a rectangle that meets the following criteria:
a.) Create in the 3rd quadrant.
b.) Is 3″ wide and 2″ high.
c.) The first point is located at the 0,0 location.
2. Create a circle using any method you want as long as it meets the following
criteria:
a.) Diameter of 2″.
b.) Center of the circle is at (-3,4).
3. Create a circle using any method you want as long as it meets the following
criteria:
a.) Diameter of 3.5″.
b.) Center of the circle is at (5,-5).
4. Create a line that is tangent to the top of the circle created in the exercise 2 and
tangent to the top of the circle created in exercise 3.
5. Create a line that is tangent to the top of the circle created in the exercise 2 and
tangent to the bottom of the circle created in exercise 3.
6. Create a line that is tangent to the top of the circle created in the exercise 2 and to
the center of the circle exercise 3.
7. Create a line that is horizontal starting at the center of the circle created in
exercise 2 and is 5 inches long.
8. Save the file as Lesson 1 Exercises.

